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Explanation of Symbols on Labels 

SYMBOL DESCRIPTION 

 

Manufacturer 

 
Date of Manufacture 

 1588 

Conformité Européenne 1588 = 
Notified Body Number for 
R&TTE 

 
Consult instructions for use. 

 

Do Not Use if Package is 
Damaged or Opened 

 

Transport Temperature Limits 

 
Sterilized with Ethylene Oxide 

 
Use By  

 
Do Not Reuse 

 
Do not resterilize 

 
Part Number 

 
Lot Number 
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SYMBOL DESCRIPTION 

 
Serial Number 

 

Open Here 

 
Torque Wrench 

 

Type B Applied Part 

 
Caution 

 
Power Indicator 

 

Intentional Radiator 

 

Signal Strength Indicator 

 USB Connector 
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Device Description 

Contents of all Packages 

Model 1002 EndoStim LES Stimulator Package 

 1 EndoStim Implantable Pulse Generator 

 1 Torque wrench (Allen-type) 

 1 Set peel-off labels 

Model 1003 EndoStim Implantable Bipolar Lead 
Package 

 1 Implantable bipolar lead 

 2 Silicone stopper discs 

 1 Set of peel-off labels 

Model 1007 EndoStim LES Programmer System (USB)  

 Model 1504 EndoStim LES Programmer USB Wand 

 Model 1505 EndoStim LES Programmer Software 

Accessories 

 Magnet 



 

2  EndoStim Lower Esophageal Sphincter Stimulation System  

Indications and Contraindications 

Indications 

The EndoStim
® 

Lower Esophageal Sphincter (LES) 
Stimulation System is intended for the treatment of 

patients with chronic gastroesophageal reflux disease 

(GERD) with symptom duration of 6 months or longer that 

has been shown to be refractory to pharmaceutical 

treatment. 

Contraindications 

The EndoStim Lower Esophageal Sphincter Stimulation 

System is contraindicated for individuals with the following 

conditions or needs: 

 Significant cardiac arrhythmia, or ectopy, or significant 

cardiovascular disease. 

 Pregnant or nursing. 

The following treatments are contraindicated for patients 

implanted with the EndoStim device: 

 Magnetic Resonance Imaging (MRI) procedure 

 Nuclear Magnetic Resonance (NMR) imaging procedure 

 Medical diathermy 

 Transcutaneous Electrical Nerve Stimulation (TENS) 

exposure in the abdominal region 

Precautions 

The EndoStim Lower Esophageal Sphincter Stimulation 

System has not been evaluated in the following 

populations. Patients with the following conditions should 

be considered prior to implant 

 Large (greater than 3 cm) hiatal hernia 

 Severe Grade D esophagitis 

 Long segment Barrett’s esophagus or Barrett’s esophagus 

with dysplasia 
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 Severe esophageal dysmotility 

 Significant uncontrolled autoimmune disorder such as 

Scleroderma, Dematomyositis, CREST syndrome, 

Sjogren’s Syndrome, or Sharp’s Syndrome, that effects 

esophageal motility 

 Severe obesity with a body mass index (BMI) greater than 

35 kg/m
2
 

 Type 1 diabetes mellitus 

 Uncontrolled type 2 diabetes mellitus (T2DM) defined as 

HbA1c > 9.5 in the previous 6 months, or has T2DM for 

more than 10 years 

 Suspected or confirmed esophageal or gastric cancer 

 Esophageal or gastric varices 

 Dysphagia due to severe esophageal peptic structure, 

excluding Schatzki’s ring 

 History of any active malignancy 

 History of previous esophago-gastric surgery such as 

laparoscopic fundoplication or an esophageal myotomy 

 Other implanted devices 

 Younger than 21 years old 

 Significant psychiatric disorder that may interfere with 

therapy 

Potential Adverse Effects/Events 

Implantation of the System 

Potential adverse effects/events associated with the implantation 

of the implantable pulse generator (IPG) and lead include, but 

are not limited to, the following: death; pulmonary embolism; 

partial or complete ileus; peritonitis; esophageal perforation by 

the electrodes; infection; inflammation; injury to organs within 

the abdominal cavity; intravenous site complications; 

pneumonia; bleeding; incisional hernia; allergic or abnormal 

reaction to anesthetic agents; pain; and fever. 
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Use of the System 

Additional adverse effects that could be associated with the 

EndoStim System include, but are not limited to, the following: 

lead/electrode dislodgement; lead erosion or perforation into the 

esophagus or stomach; IPG migration in the subcutaneous space; 

IPG erosion through the skin; diaphragmatic stimulation; 

stimulation of abdominal muscle; irritation and/or inflammatory 

response to the IPG and/or the lead; allergic reaction to 

materials; hematoma; infection; dysphagia; odynophagia; cardiac 

arrhythmia; nausea; and discomfort. LES stimulation ceases 

when the battery in the IPG is completely discharged. 

There is a potential that any system component could 

malfunction (e.g., software bug), become damaged (e.g., lead 

fracture), or the patient’s incision could become infected. System 

component malfunction or other clinical circumstances (e.g., 

sepsis) may require noninvasive corrective actions or possibly 

even a surgical revision (repositioning, replacement, or removal) 

of the malfunctioning component(s).  

It is recommended to shut the system down if the patient 

experiences severe sensation or muscle or diaphragm 

stimulation. 

Notes:  

 If necessary, use the Programmer to adjust the stimulation 

amplitude to eliminate any pain, discomfort, or sensation 

that may be related to stimulation. Reducing stimulation 

amplitude is the only recommended adjustment. After 

verifying the IPG is functioning as previously 

programmed, it is recommend reducing stimulation 

amplitude, incrementally in voltage steps of 0.5mA, until 

the adverse effect resolves. If such attempts are not 

successful, it may be necessary to use the Programmer or 

a magnet to shut down the system. 

 A dramatic increase of the lead impedance may indicate a 

partial or complete lead dislodgement. Patient symptoms 

should be monitored and, if deteriorating, x-ray or 

fluoroscopy is recommended to assess the lead and 

electrode location. 
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Warnings and Precautions 

Cremation and Incineration 

The IPG contains a sealed chemical power cell (lithium battery). 

For this reason, never incinerate an IPG. Be sure that the IPG is 

explanted before a deceased patient is cremated. Contact your 

local waste management officials for other information about the 

environmentally safe collection and disposal of the IPG. 

Reuse 

The IPG and implanted lead are intended for single use only. 

Environmental Hazards 

The following discussion reflects a conservative approach to the 

issue of patient safety in the presence of potential environmental 

hazards. Design features in the IPG minimize the potential for 

such hazards, but they cannot be ruled out completely. 

Notes: 

 Do not use any other electrical equipment adjacent to the 

EndoStim System. If the components cannot be kept 

separate, then monitor devices to assure normal operation. 

 Portable and mobile RF (radio frequency) equipment can 

interfere with the normal operation of the EndoStim 

System. The portable and mobile RF equipment should be 

considered in any situation where the EndoStim System 

devices are not acting as expected. Other equipment may 

interfere with these devices, even if that equipment 

complies with CISPR emission limits. 

As with any medical device system, all the components of the 

EndoStim System can be affected by magnetic, electrical, and 

electromagnetic signals of sufficient strength. On rare occasions, 

interfering signals could inhibit electrical stimulation delivery or, 

alternatively, trigger inappropriate delivery of electrical 

stimulation signals. In addition, certain sources can couple 

sufficient energy into the IPG to damage the circuitry of the IPG 

and/or LES tissue adjacent to the electrodes. The physician may 

wish to discuss these risks with the patient. 
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The susceptibility of a particular unit will also depend on the 

location of the IPG pocket, the nature of the interference, and the 

programmed operating parameters. 

Because of the diversity of potential causes of electromagnetic 

interference, EndoStim cannot characterize and describe within 

this manual the effects of all potential sources of interference. 

Warning: Advise patients to be cautious when in the vicinity of 

equipment that generates electrical or magnetic fields and to seek 

medical advice before entering an area posted with a warning for 

pacemaker patients (or other medical implantable devices). 

Electrocautery 

The surgical use of electrocautery can cause the IPG to become 

inactive and possibly lose statistical data. Electrocautery may 

damage the IPG and lead. Application of electrocautery close to 

an IPG can also cause damage to the LES tissue, possibly 

producing burns.  

If electrocautery is required, apply it in short bursts; position the 

ground plate on the patient to minimize current flow through the 

IPG and lead. To reduce the possibility of adverse effects, 

program the IPG to the OFF mode. Check the IPG for proper 

operation immediately following the procedure. If the unit is in 

the DOWN mode, follow the Reset procedure. 

RF Ablation 

RF Ablation can cause the IPG to revert to its DOWN mode, 

with possible loss of statistics data. If sufficient energy is 

coupled into the system, the unit may be damaged. Application 

of RF ablation in close proximity to the electrodes of an 

implanted IPG can also cause a direct coupling of radio-

frequency energy through the leads and electrodes to the LES 

tissue, possibly producing burns. 
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If RF ablation is necessary, position the ground plate as far from 

the IPG and lead as possible. Avoid direct contact with the 

ablation catheter and the IPG and lead. Program the IPG to the 

OFF mode to reduce the possibility of adverse effects. Check the 

IPG for proper operation immediately following the procedure. 

If the unit is found in the DOWN mode, follow the Reset 

procedure. 

Medical Diathermy 

Medical diathermy (short-wave thermal induction) is generally 

contraindicated for patients implanted with active medical de-

vices. It is unknown how the IPG will operate if subjected to the 

intense fields of energy. Although damage to either the circuitry 

of the IPG or LES tissue is improbable, it cannot be ruled out. 

If medical diathermy is required, apply it away from the 

immediate vicinity of the IPG and lead. Programming the IPG to 

the OFF mode reduces the possibility of adverse effects. Check 

the IPG for proper operation immediately following the 

procedure. If the unit is in the DOWN mode, follow the Reset 

procedure. 

Contraindication:  Patients and physicians should be advised 

that exposure to medical diathermy is contraindicated in patients 

implanted with the EndoStim System. 
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Defibrillation 

Any implanted active medical device can be damaged by cardiac 

defibrillation procedures. In addition, the defibrillation current 

can cause damage to LES tissue adjacent to the electrodes and/or 

to tissue surrounding the IPG. The defibrillation current may also 

cause the IPG to revert to its DOWN mode, with possible loss of 

statistics data. If sufficient energy is coupled into the system, the 

unit may be damaged. If defibrillation is necessary, position the 

paddles as far away from the implanted system as possible; avoid 

placing the IPG in the defibrillation current path between the 

paddles.  

Following defibrillation, closely monitor the performance of the 

IPG. If an operational abnormality is detected, consider 

repositioning or replacing the lead and/or reprogramming (or 

replacing) the IPG. If the IPG changes to the DOWN mode, 

follow the Reset procedure. 

Therapeutic Radiation 

Therapeutic equipment that produces ionizing radiation, such as 

linear accelerators and cobalt machines used in cancer treatment, 

can damage the type of circuitry used in most active implantable 

medical devices. Since the effect is cumulative, both dose rate 

and total radiation dosage determine whether, and to what extent, 

damage will occur. Please note that any damage to the IPG may 

not be immediately detected. 

In addition, the electromagnetic fields generated by some 

therapeutic machines as part of the energy “steering” process can 

affect the operation of the IPG. 

The effects of radiation therapy can range from temporary 

disturbance to permanent damage. Therefore, if such therapy is 

used, protect the IPG with local radiation shielding, and monitor 

its performance during and after treatment. If tissue near the 

implant site must be irradiated, it may be advisable to relocate 

the IPG. 
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MRI and NMR Imaging 

A conservative approach recommends that patients implanted 

with an IPG not be exposed to Nuclear Magnetic Resonance 

(NMR) Imaging and Magnetic Resonance Imaging (MRI). The 

EndoStim System has not been tested for safety or operation 

after exposure to this environment. 

Contraindication: Patients and physicians should be advised 

that exposure to Nuclear Magnetic Resonance (NMR) Imaging 

or Magnetic Resonance Imaging (MRI) is contraindicated when 

implanted with the EndoStim System. 

Lithotripsy 

Direct exposure of an IPG to lithotripsy shock waves can cause 

damage to the IPG. If the implant site is outside of the shock-

wave path, no clear contraindication to the use of lithotripsy can 

be established. 

As a precaution, programming the IPG to the OFF mode reduces 

the possibility of adverse effects. Check the IPG for proper 

operation immediately following the procedure. If the unit is 

found in the DOWN mode, follow the Reset procedure.  

Therapeutic and Diagnostic Ultrasound 

Direct exposure of an IPG to diagnostic ultrasound can cause 

damage to the IPG. The IPG may inadvertently concentrate the 

ultrasonic field and cause harm to the patient. 

Therapeutic ultrasound may be used if the implant site is distant 

and clearly outside of the ultrasonic field. Programming the IPG 

to OFF mode reduces the possibility of adverse effects. Check 

the IPG to assure operation immediately following the 

procedure. If the unit is found in the DOWN mode, follow the 

Reset procedure. 
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Effects on Other Implanted Devices 

The EndoStim system may affect the operation of other 

implanted devices, such as cardiac devices, other 

neurostimulators, and implantable drug pumps. Physical 

proximity may cause sensing problems and inappropriate device 

responses. Clinicians involved with both devices should evaluate 

any potential interference problems before surgery. 

Transcutaneous Electrical Nerve Stimulator  

Transcutaneous Electrical Nerve Stimulator (TENS) therapy is 

generally contraindicated for patients who have active 

implantable medical devices. The high-voltage pulses delivered 

by TENS units to the body can interfere with the operation of the 

IPG. 

If a TENS device must be used, place the TENS electrodes as far 

from the IPG and lead as possible. The TENS electrodes should 

also be placed as close as possible to each other to reduce current 

spread. The operation of the IPG should be monitored closely 

during TENS use. As a precaution, programming the IPG to the 

OFF mode reduces the possibility of adverse effects. 

Contraindication: Patients and physicians should be advised 

that exposure to TENS in the abdominal region is 

contraindicated for patients implanted with the EndoStim 

System. 

Home Appliances 

Home and commercial microwave ovens in good condition, and 

used as intended, will not affect the IPG. Even a defective oven 

that exposes the IPG to direct microwave energy may not 

damage the unit itself. Ovens using electromagnetic induction 

can cause the device to go into magnet mode (disable stimulation 

therapy output).  

Inform patients about the possibility of interference from some 

electric razors, electric power tools and electrical ignition 

systems, including those used on gasoline-powered devices. In 

general, patients who have an IPG may operate gasoline-

powered devices if protective hoods, shrouds, and other 

shielding remain in place. 
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Antitheft Systems 

Certain types of antitheft devices, such as those used at 

entrances/exits of retail stores, libraries and other establishments, 

can interfere with the IPG. Most commonly, interference may 

result in electrical stimulation delivery inhibition. Instruct 

patients to walk at a normal pace and avoid lingering when 

passing through the entrances and exits of these establishments. 

Industrial Machinery 

High voltage power lines, electric arc welders, electric smelting 

furnaces, and power-generating equipment can interfere with the 

operation of the IPG. For this reason, the intensities and 

modulation characteristics of the electromagnetic fields 

encountered by patients as a result of their occupation and 

lifestyle should be considered. When appropriate, give specific 

warnings. 

Radio Transmitters 

Communications equipment such as radio and TV transmitters 

(including amateur “ham” transmitters, microwave transmitters 

and CB transmitters with high-power linear amplifiers) and radar 

transmitters can interfere with the operation of the IPG. Discuss 

this with patients whose occupations may expose them to these 

electromagnetic fields. When appropriate, give specific 

warnings. 
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Cellular Phones 

Cellular and other portable telephones can interfere with the 

operation of the IPG. Potential effects may result from either the 

radio frequency emitted by these telephones or the magnet 

within the phone’s speaker. These effects may include inhibition 

or inappropriate triggering of electrical stimulation delivery 

when the phone is in close proximity (within 25 cm) to the IPG 

and the lead.  

Advise patients to hold the phone to the ear opposite the side of 

the implanted IPG. Patients should not carry the phone in a 

breast pocket or on a belt over or within 25 cm of the implanted 

IPG because some phones emit signals when they are turned on 

though not in use. 

Airport Screening Systems 

Globally, passenger-screening systems encountered in airports 

may interfere with the IPG. Most commonly, interference may 

result in electrical stimulation inhibition. Instruct patients to 

inform security personnel about the implanted medical device, to 

show their identification card, and to walk at a normal pace when 

passing through the portal of these systems. No damage to the 

implanted system should occur. 

Magnets 

Application of a magnet directly over the IPG for at least 2 

consecutive seconds, followed by 2 consecutive seconds without 

a magnet, will terminate therapy for 24 hours. 

General Precaution 

The EndoStim System may fail to properly operate for any 

number of reasons, including but not limited to: random 

component failure (including the battery), lead failure (including 

electrical shorts, opens, and insulation faults), and software 

errors. The frequency of these events cannot be predicted.
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System Overview 

This section provides descriptions of all the components for the 

Model 1008 EndoStim
®
 Lower Esophageal Sphincter 

Stimulation System. Throughout the instructions in this manual, 

you may see the terms stimulator and IPG (implantable pulse 

generator). These terms refer to the same type of device. 

The system consists of an IPG, bipolar stimulating lead, and a 

Programmer. 

 

Figure 1 EndoStim LES System 

Implantable Pulse Generator 

General Description 

The EndoStim implantable pulse generator (IPG) (Figure 2), is 

an internally powered (lithium battery) device that delivers 

electrical stimulation pulses to the lower esophageal sphincter 

(LES). The IPG is hermetically sealed in a titanium case (Figure 

2). It delivers electrical pulses to the LES via a bipolar IS-1 BI 

header connector port (Figure 3) that connects the IPG and lead. 

The IPG is sterilized with ethylene oxide. 
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Figure 2 EndoStim LES 
Stimulator 

 

Figure 3 IPG Header 
Connector 

 

 

The programmable IPG communicates with the external 

Programmer via telemetry. Medical and technical personnel use 

the Programmer to program parameters that control the IPG 

function. The IPG may be programmed specifically for 

individual patients by changing the settings parameters within 

the implanted device. In addition, the Programmer can access 

performance data that the IPG collects during its normal 

operation. 
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Handling and Storage 

Do not implant the IPG if the package is damaged or if the IPG 

has been dropped from a height of 30 cm or more. Return 

damaged packages to EndoStim B.V.  

Store the IPG at a temperature range of 20°C to 25°C and in a 

dry location. Do not allow the sterile packaging to become damp 

or wet because sterilization of the contents may be compromised. 

Exposure to temperatures below 0°C may cause a change in the 

parameter values of the IPG to the DOWN mode (no output). 

Once the IPG is removed from the extreme environment, it will 

either return to the programmed settings, or it will remain in the 

DOWN mode. In the latter case, follow the Reset procedure. If 

unsuccessful, the unit should be returned to EndoStim B.V. 

Re-sterilization and Re-Use 

The IPG and torque wrench are single-use devices. Do not re-

sterilize the IPG or torque wrench. Do not re-use an explanted 

IPG: the device must not be used for implantation in another 

patient. 

 X-Ray Identification 

A radiopaque marker placed within the IPG allows the model 

number and year of manufacture to be identified by normal X-

ray techniques. The manufacturer’s identification code for 

EndoStim is E, the code for the EndoStim IPG model is A, and 

the code for the year of manufacture is XX, where XX is 

replaced by the last two digits of the calendar year in which the 

device was manufactured. 
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Implantable Bipolar Stimulating Lead 

General Description 

The EndoStim lead, called the Implantable Bipolar Stimulating 

Lead, is used in conjunction with the IPG. The lead has an IS-1-

BI connector
1
 at the proximal end for attachment to the IPG 

(Figure 4). The lead is sterilized with ethylene oxide. 

The lead delivers stimulation pulses to the tissue through stitch 

electrodes at the distal end. During implantation, the stitch 

electrodes of the leads are sutured into the LES and secured into 

place. The electrodes of the bipolar lead are implanted in the 

sero-muscular layer of the LES (Figure 5).  

 

 

 

 

 

Figure 4 EndoStim Lead and 
IPG 

 

 

 

Figure 5 Implanted EndoStim 
Lead and IPG 

                                                 

 

 
1 Implants for Surgery – Cardiac Pacemakers – Part 3: Low-profile connectors 

[IS-1] for implantable pacemakers, ISO 5841-3:2000(E) 
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Physical Characteristics 

The implantable lead is constructed of biocompatible materials: 

an inner and outer silicone rubber sheathing, cobalt/nickel 

conductors, and platinum-iridium stitch electrodes. A curved 

stainless steel suture needle is affixed to the end of each stitch 

electrode. The lead is 45 cm in length from the IS-1-BI 

connector tip to the end of the platinum-iridium electrodes. The 

lead bifurcates after 35 cm into individual, unipolar leads, with 

the length of each unipolar lead being 10 cm. 

Handling and Storage 

Do not implant the lead if the package is damaged or if the lead 

has been dropped from a height of 30 cm or more. Return 

damaged packages to EndoStim, B.V. 

Store the lead at a temperature range of 20°C to 25°C and in a 

dry location. Do not allow the packaging to become damp or wet 

because sterilization of the contents may be compromised. 

 Re-Sterilization and Re-Use 

The lead is a single-use device. Do not re-sterilize the lead 

or silicone stoppers. Do not re-use an explanted lead; the 

device must not be used for implantation in another patient. 

Programmer 

General Description 

Use the EndoStim LES System Programmer to interrogate and 

program the IPG. The Programmer software runs on an 

IEC60950 certified laptop personal computer (PC), which runs 

on battery power. Communication between the Programmer and 

the IPG is accomplished with the Programmer placed directly 

over the implant site. The Programmer communicates via 

magnetic induction telemetry with the IPG implanted in the 

patient. 
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Note: Avoid skin contact between the patient’s skin and the 

Programmer Wand, when possible, to avoid any potential cross-

contamination from previous use of the Programmer. 

The Programmer can  

 Read (interrogate) IPG parameters as currently 

programmed 

 Modify IPG parameters 

 Retrieve statistics accumulated by the IPG as it operates 

 Log the activity of the IPG 

 Store standard programs for future use 

The Programmer has 2 components (Figure 6): 

 Programmer Wand 

 Programmer Software 

 

 

 

Figure 6 EndoStim LES System Programmer 
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Electrical Characteristics 

The Programmer is internally-powered Type B equipment that is 

suitable for continuous use. The Programmer is considered an 

applied part and the Programmer laptop is considered out of the 

patient environment (at least 1.5 meters from the patient). 



 

20  EndoStim Lower Esophageal Sphincter Stimulation System  

Loading the Software 

You must install the Programmer software on an IEC60950 

certified laptop that has Microsoft
®
 Windows

®
 7. The minimum 

functional requirements of the computer are the same as those 

required for Microsoft Windows 7. The computer must support a 

screen resolution of 1024 x 768.  Follow these steps to install the 

software: 

1. Close all open applications. 

2. Insert the CD into the CD or DVD drive. 

3. Wait for the computer to recognize the CD and open a 

folder. 

4. Double-click the icon EndoStim Neurostimulator Setup 

Win7. 

5. Click “Yes” if prompted to allow software access. 

6. The computer restarts immediately. 

7. At the “Setup Welcome” screen, click “Next.” 

8. At the “Choose User” screen, choose the appropriate user(s). 

9. At the “Choose Components” screen, ensure that all boxes 

are checked. 

10. At the “Choose Install Location” screen, choose the desired 

location for the software to install. 

11. At the “Insert Application Password” screen, type the 

password you want to use in both locations; then click 

“Accept.” 

12. At the “Installation Complete” screen, click “Next." 

13. At the “Completion” screen, click “Finish.” 

Powering the Programmer 

The Programmer is powered from the USB port of the laptop 

(5V, 0.5A). Connecting the laptop to Mains is not allowed while 

the Programmer is connected. Operate the Programmer using 

only the laptop computer battery. Use the AC connection only 

when recharging the laptop, and ensure that the USB cable is 

disconnected from the laptop. 
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If the laptop is connected to Mains, the Programmer software 

disables power to all computer USB ports and provides a popup 

warning (Figure 7). The popup warning message terminates once 

the laptop is disconnected from the Mains and you press “Retry. 

The Programmer shuts down if you press “Close.”  

 

Figure 7 Programmer Connection to Mains Warning 

Notes:  

 When recharging the laptop, connect the laptop charger to 

the Mains per labeling on the laptop charger. 

 It is recommended that you routinely charge the battery of 

the laptop between uses. 

Connect the Programmer 

Connect the USB end of the Programmer to the USB port of the 

laptop computer. 

Note: The Programmer should only be connected to the USB 

port of an IEC60950 certified laptop that runs on battery power 

only. 
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Maintenance 

The Programmer Wand does not contain any user serviceable 

parts. If any Programmer Wand parts become damaged or loose, 

or it does not function properly, return the Programmer Wand to 

EndoStim B.V. 

After each use, it is recommended that you disconnect the 

Programmer Wand from the USB port of the laptop computer. 

To clean the Programmer, use a soft cloth dampened with 

distilled water, methanol, or isopropyl alcohol to wipe the 

exterior case of the Programming Wand. Do not use solvents or 

cleaning cloths infused with chemical cleaning agents. 

Warnings:  

 The Programmer is not protected against the ingress of 

water (IXP0). Avoid immersing the Programmer in any 

fluids. 

 Do not use the Programmer in the presence of flammable 

anesthetics. 

 Do not sterilize the Programmer. 

 Do not connect any other equipment to the Programmer. 

 Do not modify the Programmer in any way. 

Handling and Storage 

Do not use the Programmer if the package is damaged or if the 

Programmer has been dropped from a height of 1 meter or more. 

Return damaged packages to EndoStim B.V.  

The Programmer environmental conditions are found in Table 1. 

Table 1 Environmental Conditions for the Programmer 

Condition Shipping Operating and 
Storage 

Temperature -20-70 ºC (-4-158 ºF) 5-37 ºC (41-104 ºF) 
Humidity 15-93 % non-condensing 15-93 % non-condensing 
Atmospheric 
Pressure 

54.0-101.3 kPa (7.8-14.7 
psi) 

54.0-101.3 kPa (7.8-14.7 
psi) 

Altitude  0-5000 m (0-16,404 ft) 0-5000 m (0-16,404 ft) 
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Environmental conditions for the laptop may be different than 

the Programmer.  Check laptop user manual for laptop 

environmental ranges and assume worst case condition. 

Service Life and Disposal 

The life of service is expected to be 5 years. The Programmer 

should be returned to EndoStim B.V. when disposal is required.  

Environment of Use and Operator Profile 

The operators of the Programmer include physicians in charge of 

either implanting or monitoring an IPG, and trained medical 

personnel who assist physicians. Operators will be familiar with 

operation of electronic medical equipment, particularly IPGs, 

and programmers and / or the operators will have been trained on 

the operation of the EndoStim Programmer. 

The Programmer is used in an operating room where the IPG is 

being implanted. When in the operating room, the Programmer 

should be brought into the sterile field through a sterile sleeve 

while the laptop remains outside the sterile field. The surgeon 

should place the Programmer over the IPG while an appropriate 

person outside the sterile field operates the Programmer. 

The Programmer is also used in a clinical room where patients 

with an implanted IPG are monitored. When in the clinic, the 

clinician should place the Programmer over the IPG and have 

either an assistant or the patient hold the Programmer in place. 

The patient can sit or lie down. The laptop should be outside the 

patient environment, at least 1.5 meters away, and operated by 

the clinician. 

To be compliant with electromagnetic compatibility 

requirements (interference characteristics), the Programmer 

should not be used adjacent to or stacked with other equipment. 

If adjacent or stacked use is necessary, verify that the 

Programmer functions properly. It is recommended to have an 

additional Programmer present at each implant and clinic visit. 
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Instructions for Use: Program an IPG 

Launch the Software 

Double-click the EndoStim icon on the desktop to launch the 

Programmer software. The password screen appears (Figure 8). 

 

Figure 8 EndoStim Programmer Password Screen 

Enter the password and press “Accept” or press Enter. The 

Programmer Main Screen appears (Figure 9). 

 

Figure 9 EndoStim Programmer Main Screen 
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The screen is divided into two sections, Information and 

Programming. 

 Information — The top section (above the solid horizontal 

line) contains icons for retrieving and displaying device 

information. These are labeled below: 

ICON DESCRIPTION 

 

Interrogate 
Click on this icon to interrogate the IPG. 

 

Serial Number 
The serial number of the IPG is displayed here. 

 

Battery Voltage 
The battery voltage of the IPG is displayed here. 

 

Lead Impedance 
The lead impedance is displayed here. 
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 Programming — The lower section (below the solid 

horizontal line) contains icons for programming the device 

parameters. These are labeled below: 

ICON DESCRIPTION 

 

Stimulation Amplitude and Polarity 

Click on the top button of this icon  to 
program the stimulation amplitude. Click on the 

lower icon  to reverse polarity. 

 

Program 
Click on this icon to program the IPG. 

 

Urgent Programming 
The battery voltage of the IPG is displayed here. 

 

Stimulation Session Timing – Awake 
Click on the time icons below this icon to 
schedule stimulation sessions while the patient is 
awake. 

 

Stimulation Session Timing – Asleep 
Click on the options below this icon to schedule 
stimulation therapy while the patient is sleeping. 

 

NOTE: The Programmer automatically disables certain 

parameters and icons based upon values of other parameters or 

states of other icons.  For an icon example, the Program icon 

will not be active unless a parameter was changed.  For a 

parameter example, the Stimulation Session Timing – Awake will 

not allow for programming two stimulation sessions immediately 

adjacent to each other (see Figure 14 below). 
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Initiate a Programming Session 

To initiate a programming session, place the Programming Wand 

over the IPG. Red and green LED lights indicate 2 types of 

communication: 

 Communication — At least one of the Signal Strength 

LEDs blinks about once per second.  

 Stronger communication — Green LEDs at the top blink 

 Weaker communication — Red LEDs at the bottom blink. 

Press the Interrogate icon  at the far left of the Information 

section. The remaining 3 icons in the Information section of the 

Programmer screen should be filled in with appropriate values as 

shown in Figure 10. 

 

Figure 10  Information on the Main Screen 
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Program IPG Time 

Select the pull-down menu Tools→Time . The Time dialog 

window opens (Figure 11 ). 

 

Figure 11 EndoStim Programmer Time Dialog 

1. Verify that the System Current Time matches the PC 

time.  

2. Select Get Time. The message Get Time OK appears. 

3. Select Set With PC Time. 

4. If Daylight Savings Time is required, select DST Enable 

and the Start date and Stop date. 

5. Select Close. 

Note: It is important to ensure that the time of day is always the 

same between the IPG and the Programmer. If the time, or clock, 

is not synchronized, the patient may receive therapy that is off-

schedule. For example, if there is a difference of 1 hour between 

the IPG and Programmer, the patient may receive therapy during 

a meal.  
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Measure Lead Impedance 

To measure lead impedance, select the pull-down menu 

Tools→Impedance Measure. There will be a slight delay while 

the impedance is being measured, and the impedance will be 

displayed in the Lead Impedance icon . If the impedance is 

too high or too low, the text Out of Range appears in the icon. 

Significant shifts in lead impedance that are not out of range may 

require adjustments in stimulation amplitude to accommodate for 

the changes.  

Access IPG Statistics 

1. To access the IPG statistics, select the pull-down menu 

Tools→Read Statistics . The Statistics window opens 

(Figure 12). 

 

Figure 12 EndoStim Programmer Statistics Window 

2. The statistics window displays the timestamp and total 

number of stimulation therapy sessions delivered and 

those not delivered.  

3. To reset the statistics, select the pull-down menu 

Tools→Clear Statistics . 

Program Stimulation Amplitude and Polarity 

1. Select the upper icon  inside Stimulation 

Amplitude and Polarity icon . This will provide a 

popup menu of stimulation amplitude options (Figure 

13).  
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Figure 13 Stimulation Amplitude Options 

Select amplitude from the menu and click the Program icon . 

2. Select the lower icon  inside Stimulation Amplitude 

and Polarity icon . This icon inverts  and 

changes the polarity of stimulation between the 

electrodes. Click the Program icon . 
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Program Stimulation Session Times while Patient 
is Awake 

1. Click on the desired stimulation time boxes for the 

patient. The boxes fill, followed by an “X” in boxes 

below indicating that therapy is not possible at those 

times (Figure 14, abbreviated).  

2. Click on the Program icon . 

 

Figure 14 Stimulation Session Times while Patient is Awake, 
Example is for stimulation sessions at 08:30, 12:30, and 20:30 
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Program Stimulation Session Times while Patient 
is Asleep 

The IPG includes a sensor that detects when the patient is 

sleeping. A repeating stimulation session can be programmed 

while the patient is sleeping. This therapy will automatically 

terminate when the IPG detects that the patient is awake and 

upright. To enable stimulation sessions when the patient is 

asleep, click on the desired frequency of stimulation sessions 

(Figure 15). If no therapy is required for when the patient is 

asleep, then click “OFF.” Click on the Program icon . 

 

Figure 15 Stimulation Session Times while Patient is Asleep, 
Example is for stimulation sessions once every 3 hours starting 

when patient goes to sleep 

Calibrate Posture Sensor 

With the patient standing upright and not moving, select the pull-

down menu Tools→Set Stand Vector. This calibrates the sensor 

to the upright position. 
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Advanced Parameters 

If more therapy flexibility is required, more options can be found 

by selecting the pull-down menu Tools→Advanced  (Figure 16). 

 

Figure 16 Advanced Stimulation Parameters 

Advanced Timing Parameters 

 Dose Time — This sets the duration of the stimulation 

session. It is recommended to set this to 30 minutes. 

 Block Time — This sets the duration of time after a 

stimulation session where another stimulation session 

cannot occur for any reason. It is recommended to set this 

to 60 minutes. 

 Active Time — This sets the duration of the stimulation 

session. It is recommended to set this to 30 minutes. 

 Inactive Time — This sets the duration of the time 

between consecutive stimulation sessions. 

Advanced Stimulation Parameters 

 Pulse Width —This sets the width of the stimulation 

pulse. It is recommended to set this to 215 sec. 

 Frequency: This sets the rate (or frequency) at which the 

pulses are delivered. It is recommended to set this to 20 

Hz (e.g., 20 pulses per second). 

Impedance Tracker: When enabled, this automatically adjusts the 

stimulation voltage to accommodate changes in lead impedance. 

This ensures the programmed current is delivered independent of 

lead impedance. Parameters Max Volt, Min Volt, and Max  

Volt place boundaries on the amount that changing lead 

impedance can change stimulation voltage. Click on the 
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“Recommended” icons to use suggested parameters. 

Advanced Sensing Parameters 

 Supine Time — This is the amount of time the patient 

must maintain the Supine Level and be still. It is 

recommended to set this to 30 minutes. 

 Supine Level — This is the angle, in degrees, that the 

patient must be to detect a supine position. Patient 

standing (vertical) is considered 0˚ and lying down 

(horizontal) is 90˚. It is recommended to set this to 70˚. 

 Minute % — This is the percentage of 1 minute segments, 

within the Supine Time, that the patient remains still and 

in the Supine Level. It is recommended to set this to 90%. 

 Supine Time % — This is the percentage of time, within 

1minute, that the patient remains still and in the Supine 

Level. It is recommended to set this to 90%. 
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Terminate Stimulation 

To stop stimulation, program the amplitude to OFF on the 

amplitude icon , and then select the Program button. 

You can also use the Urgent Programming icon  to stop 

stimulation at any time. 

Reset the IPG 

To reset the IPG, select the pull-down menu.Tools→Reset IPG  

Shut Down the Programmer 

To turn off the Programmer: 

 Click on the X at the top right of the screen OR select the 

pull-down menu File→Exit. 

 Disconnect the USB cable from the computer. 

 Turn the computer off. 

Implant the EndoStim System 

Laparoscopic surgery is generally used for the implantation of 

the EndoStim System. An open, bariatric surgical approach may 

also be appropriate for some patients. Minimal use of narcotics is 

recommended. Follow standard sterile technique and adhere to 

standard operating room procedures. 

Warning: The implanting physician is required to undergo 

formal training by an EndoStim expert representative prior to 

implanting the system in humans. 
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System Specifications 

This section contains specifications and characteristics for all the 

devices included in the LES system: IPG, Bipolar lead, and 

Programmer. 

IPG Specifications 

Table 2 Implantable Pulse Generator Specifications 

Description Value 

Height 65 mm 
Width 48 mm 
Thickness 12 mm 
Mass 50 g 
Biocompatible materials in 
contact with human tissue 

Titanium 
Epoxy resin 
Silicone rubber set plugs 

Power source Lithium carbon monoflouride 
battery 

Storage temperature 20°C to 25°C 

  

IPG Battery Characteristics and Specifications 

The battery voltage at beginning of life is approximately 3.3V 

and the usable capacity is 2.5 Ah. When battery voltage falls 

below 2.5V, the device sends information to the Programmer, 

upon interrogation, that the battery is near the end of life. In 

addition, stimulation amplitude will be reduced if programmed at 

greater than 3 times the battery voltage. When battery voltage 

falls below 2.3V, the device will turn off all stimulation outputs. 

When the battery voltage falls below 2.1V, communication with 

the Programmer will no longer be possible. 

The longevity of the battery can be estimated based on the 

different stimulating parameters applied, as described in Table 3. 



 

 

EndoStim Lower Esophageal Sphincter Stimulation System   37 

 

Table 3 Estimated IPG Battery Longevity 

Parameter Condition 
1 

Condition 
2 

Condition 
3 

Condition 
4

d
 

Pulse 
Width

a
 

215 sec 215 sec 215 sec 215 sec 

Pulse 
Frequency

a
 

20 Hz 20 Hz 20 Hz 20Hz 

Pulse 
Amplitude

b
 

2.0 V 2.0 V 1.6 V 7.5V 

Hours per 
Day 

2.5 5.0 2.5 24 

Lead 
Impedance 

400Ω 400Ω 200Ω 750Ω 

Estimated 
Life

c
 

13.8 years 11.2 years 12.6 years 1.5 years 

a This is the recommended value 
b  

Recommended to never exceed 0.01*(Lead Impedance) 
c 
This assumes a 12 month shelf life prior to implant 

d 
Recommended to never program continuous stimulation (24 hours) 
outside the clinic environment

 

 

Lead Characteristics and Specifications 

Table 4 Lead Physical Description and Materials 

Lead Specification 

Connector IS-1 BI 
Length 45 cm 
Mass 4 g 
Electrodes Platinum-iridium 

Bifurcation 
At 35 cm, lead has two 10cm 
unipolar segments 
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Programmer Specifications 

Table 5 Programmer Specifications 

Description Value 

Height 140 mm 
Width 62.7 mm 
Thickness 30.5 mm 
Mass 251 g 
Storage temperature 5°C to 37°C 

  

Safety Shutdown with a Magnet 

Therapy signal delivery of the IPG can be shut down for 24 

hours if it is exposed to a magnetic field. A standard pacemaker 

safety magnet can be used. 

Electromagnetic Interference 

The center frequency of the EndoStim Programmer transmitter 

(to the EndoStim IPG) is 20 kHz with a bandwidth of 18 kHz to 

22 kHz. 

The center frequency of the EndoStim Programmer receiver 

(from the EndoStim IPG) is 10 kHz to 28 kHz. 
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Electromagnetic Emissions 

Guidance and manufacturer’s declaration – 
electromagnetic emissions  

The EndoStim IPG and Programmer is intended for use in the 

electromagnetic environment specified in Table 6. The customer 

or user of the EndoStim IPG and Programmer should assure that 

it is used in such an environment. 

Table 6 Electromagnetic Emissions 

The EndoStim IPG and Programmer are intended for use in the 
electromagnetic environment specified below. The customer or user 
of EndoStim IPG and Programmer should assure that it is used in 

such an environment. 

Emissions test Compliance Electromagnetic environment 
- guidance 

RF emissions   
CISPR 11 

Group 1 

The EndoStim IPG and 
Programmer use RF energy 
only for its internal function. 
Therefore, their RF emissions 
are very low and are not likely 
to cause any interference in 
nearby electronic equipment. 

RF emissions 
CISPR 11 

Class A 
The EndoStim IPG and 
Programmer are suitable for 
use in all establishments other 
than domestic establishments 
and those directly connected 
to the public low-voltage 
supply network that supply 
buildings used for domestic 
purposes. 

Harmonic 
Emissions 
IEC 61000-3-2 

Not 
Applicable 

Voltage 
Fluctuations/Flicker 
Emissions 
IEC 61000-3-2 
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ESD and Power Fluctuations 

Guidance and manufacturer’s declaration – 
electromagnetic immunity  

The EndoStim Programmer is intended for use in the 

electromagnetic environment specified in Table 7. The customer 

or user of the EndoStim Programmer should assure that it is used 

in such an environment. 

Table 7 ESS and Power Fluctuations: Electromagnetic 
Immunity 

Immunity 
test 

IEC 60601 
Test level 

Compliance 
level 

Electromagnetic 
environment - 
guidance 

Electrostatic 
discharge (ESD) 

IEC 61000-4-2 

±6 kV 
contact 

±8 kV air 

±6 kV contact 

±8 kV air 

Floors should be wood, 
concrete or ceramic tile. 
If floors are covered with 
synthetic material, the 
relative humidity should 
be at least 30%. 

Electrical fast 
transient/burst 

IEC 61000-4-4 

Not 
Applicable 

Not Applicable Mains power should only 
be used to recharge the 
laptop computer battery 
while the unit is powered 
off. 

Surge 

IEC 61000-4-5 

Not 
Applicable 

Not Applicable Mains power should only 
be used to recharge the 
laptop computer battery 
while the unit is powered 
off. 

Voltage dips, 
short 
interruptions and 
voltage 
variations on 
power supply 
input lines 

IEC 61000-4-11 

Not 
Applicable 

Not Applicable Mains power should only 
be used to recharge the 
laptop computer battery 
while the unit is powered 
off. 

Power frequency 

(50/60 Hz) 

IEC 61000-4-8 

3 A/m 3 A/m Power frequency 
magnetic fields should 
be at levels characteristic 
of a typical location in a 
residential environment. 
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 Radiated Electromagnetic Fields 

Guidance and manufacturer’s declaration – 
electromagnetic immunity 

The EndoStim Programmer is intended for use in the radiated 

electromagnetic fields specified in Table 8. The customer or user 

of the EndoStim Programmer should assure that it is used in such 

an environment. 

 

Portable and mobile RF communications equipment should be 

used no closer to any part of the EndoStim Programmer, 

including cables, than the recommended separation distance 

calculated from the equation applicable to the frequency of the 

transmitter. 

 

Table 8 Radiated Electromagnetic Fields: 
Electromagnetic Immunity 

Immunity test IEC 
60601Test 

level 

Compliance 
level 

Recommended 
Separation 
Distance 

Conducted RF, IEC 
61000-4-6, 150 kHz 
to 80 MHz outside 
ISM bands  

3 Vrms 

 

3Vrms 



d 1.17 P  

Conducted RF, IEC 
61000-4-6, 150 kHz 
to 80 MHz inside 
ISM bands 

3 Vrms 3Vrms 



d 1.20 P  

Radiated RF, IEC 
61000-4-3, 80 MHz 
to 800 MHz 

3 V/m 3 V/m 



d 1.20 P  

Radiated RF, IEC 
61000-4-3, 800 MHz 
to 2.5 GHz 

3 V/m 3 V/m 



d  2.30 P  
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Notes: 

 P is the maximum output power rating of the transmitter in 

watts (W) according to the transmitter manufacturer, and d 

is the recommended separation distance in meters (m). 

 Field strengths from fixed radio frequency (RF) 

transmitter, as determined by an electromagnetic site 

survey
a
, should be less than the compliance level in each 

frequency range.
b
 

 Interference may occur in the vicinity of equipment 

marked with the ionizing radiation symbol: 

 

At 80 MHz and 800 MHz, the higher frequency range applies. 

These guidelines may not apply in all situations. Electromagnetic 

propagation is affected by absorption and reflection from 

structures, objects and people. 
a
Field strengths from fixed transmitters, such as base stations for 

radio (cellular/cordless) telephones and land mobile radios, 

amateur radio, AM and FM radio broadcast and TV broadcast 

cannot be predicted theoretically with accuracy. To assess the 

electromagnetic environment due to fixed RF transmitters, an 

electromagnetic site survey should be considered. If the 

measured field strength in the location in which the EndoStim 

Programmer is used exceeds the applicable RF compliance level 

above, the EndoStim Programmer should be observed to verify 

normal operation. If abnormal performance is observed, 

additional measures may be necessary, such as relocating the 

EndoStim Programmer. 
b
Over the frequency range 150 kHz to 80 MHz, field strengths 

should be less than 3 V/m. 
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Recommended Separation Distances 

Recommended separation distances between portable 
and mobile RF communications equipment and the 
EndoStim Programmer 

The EndoStim Programmer is intended for use in an 

electromagnetic environment in which radiated RF disturbances 

are controlled (Table 9). The customer or user of the EndoStim 

Programmer can help prevent electromagnetic interference by 

maintaining a minimum distance between portable and mobile 

RF communications equipment (transmitters) and the EndoStim 

Programmer as recommended  (according to the maximum 

output power of the communications equipment). 

Table 9 Recommended Separation Distances Between 
RF Equipment and EndoStim Programmer 

Rated 
maximum 

output 
power of 

transmitter 
(W) 

Separation distance according to 
frequency of transmitter 

150 kHz to 
80 MHz 



d 117 P  

80 MHz to 
800 MHz 



d  0.35 P  

800 MHz to 
2.5 GHz 



d  0.70 P  

0.01 0.12 0.04 0.07 

0.1 0.37 0.11 0.22 

1 1.17 0.35 0.7 

10 3.7 1.11 2.22 

100 11.7 3.5 7.0 

 

Notes: 

For transmitters rated at a maximum output power not listed 

above, the recommended separation distance (d) in meters (m) 

can be estimated by using the equation applicable to the 

frequency of the transmitter, where P is the maximum output 

power rating of the transmitter in watts (W) according to the 

transmitter manufacturer. 

 At 80 MHz and 800 MHz, the higher frequency range 

applies. 
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These guidelines may not apply in all situations. Electromagnetic 

propagation is affected by absorption and reflection from 

structures, objects, and people. 

Range and Tolerance of Displayed Values 

IPG and Lead Parameters 
Parameter Range Increment Tolerance 

Serial 0001 to 9999 1 N/A 

Battery 2.10 to 3.10 (V) 0.01V 0.05V 

Impedance 200 to 2000 (Ω) 1 Ω 

Max of 
100Ω and 
20% 

Stimulation Parameters 
Parameter Range Increment Tolerance 

Pulse Width 30 to 975 (sec) 30sec Max of 5% 
and 

15sec 

Pulse 
Amplitude 

2.0 to 10.0 (mA) 0.5mA Max of 
0.5mA 
and 20% 

Pulse Rate 2 to 80 (Hz) 2-10Hz: 1Hz 
10-40Hz: 
2Hz 
40-80Hz: 
5Hz 

Max of 1% 
and 

100sec 

Active Time 00:00:01 to 
23:59:59 

1sec 2sec 

Inactive Time 00:00:01 to 
23:59:59 

1sec 2sec 

Duty Cycle 1 to 99 (%) 1% 1% 

Dose Mode Parameters 
Parameter Range Increment Tolerance 

Dose Time 
00:00:01 to 
23:59:59 

1sec 2 sec 

Block Time 0.5 to 4.0 (hr) 0.5hr 2 sec 

Dose 
Schedule 

00:00 to 23:30 30min 2 min 

Sensing Parameters 
Parameter Range Increment Tolerance 

Supine Time 1, 5, 30, or 60 
(min) 

N/A 1 min 

Supine Level 50 to 80 (˚) 10˚ 10˚ 
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Minute % 70, 80, 90, or 95 
(%) 

N/A 1% 

Supine Time 
% 

70, 80, 90, or 95 
(%) 

N/A 1% 

Service and Warranty 

EndoStim provides emergency device consultation on a 24-hour 

basis. If you require emergency assistance, please contact the 

following number +1-866-510-1003. 

EndoStim warrants that all IPGs and accessories (including 

associated firmware and software) will be free from defects in 

workmanship and materials for a period of 12 months after the 

original implantation of the IPG (the “Warranty Period”).  

If it appears that an IPG contains a defect in workmanship or 

materials, or fails to conform to applicable specifications, 

EndoStim will replace the defective or non-conforming 

components free of charge. The Warranty Period for a replaced 

component shall be the longer of the time remaining on the 

original Warranty Period or nine months from delivery of the 

replaced item.  

If a system component completely fails to function within the 

first 72 hours of operation, EndoStim will replace the failed item 

with a new one.  

EndoStim shall not be liable under this warranty if testing 

and examination discloses that the alleged defect or non-

conformity in the system component does not exist or was 

caused by the end user's misuse, neglect, improper 

implantation or testing, unauthorized attempts to repair, or 

by accident, fire, lightning or other hazard. 
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